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1. Vigtigt

Denne elektroniske brugervejledning er
beregnet til alle, der bruger Philips-skaermen.
Tag den tid du behgver for at lese vejledningen,
inden du bruger skeermen. Den indeholder
vigtige oplysninger om bemaerkninger angdende
brugen af din skaerm.

Philips garanti daekker under forudsztning af,

at produktet behandles korrekt og anvendes til
det tilsigtede formal i overensstemmelse med
dens brugervejledning, og ved forevisning af den
originale faktura eller kvittering med angivelse af
kabsdatoen, forhandlerens navn samt model og
produktionsnummer for produktet.

1.1 Sikkerhedsforanstaltninger og
vedligeholdelse

O Advarsler

Anvendelse af betjeningselementer; justeringer
eller fremgangsmadder, der ikke er beskrevet |
denne dokumentation, kan resultere | elektrisk
stad, elektriske ulykker og/eller mekaniske
ulykker.

Lees og felg disse vejledninger; ndr du tilslutter
og anvender din computerskarm.

Betjening

* Hold venligst skeermen vk fra direkte
sollys, meget steerkt og lyst lys samt fra alle
varmekilder. Langere tids udsettelse for
sadan et miljg kan resultere i misfarvning
og skade pa skarmen.

* Fern alt, der kan risikere at falde i
ventilationsabningerne eller forhindre
korrekt afkgling af skeermens’ elektronik.

* Bloker ikke ventilationsabningerne pa
kabinettet.

* Under placering af skeermen skal du sikre
dig, at det er let at komme til stremstikket
og stikkontakten.

* Huvis der slukkes for skeermen ved at fjerne
stremkablet eller jeevnstremsledningen,
skal du vente 6 sekunder, for du sztter

stremkablet eller jevnstremsledningen til
igen for at opna normal betjening.

* Brug altid et godkendt stremkabel, der
er leveret af Philips. Hvis du mangler dit
stremkabel, skal du kontakte dit lokale
servicecenter. (Se Informationscenter for
kundepleje)

* Udset ikke skaermen for kraftige
vibrationer eller stad under anvendelse.

* SId ikke pd skeermen, og undgd at tabe den
under brug eller transport.

Vedligeholdelse

* Som en beskyttelse af skeermen skal du
undgd at trykke kraftigt pa LCD skaermen.
Nar du flytter din skeerm, sa tag fat
om rammen for at Iafte den. Laft ikke
skeermen ved at sztte din hand eller fingre
pa LCD skarmen.

» Tag stikket ud fra skaeermen, hvis du ikke
skal bruge den i en leengere periode.

* Tag stikket ud at kontakten til skeermen,
hvis du skal rengere den med en let fugtet
klud. Skeermen kan tgrres af med en tor
klud, nar der er slukket for strgmmen.
Under alle omstaendigheder, ma der ikke
bruges organiske opl@sningsmidler til
renggring af din skaerm.

* Forat undgd risiko for elektrisk stad eller
permanent beskadigelse af anlegget, ma du
ikke udseette skeermen for stev, regn, vand
eller miljger med hgj fugtighed.

e Huvis din skeem bliver vad, skal den terres af
med en ter klud sd hurtigt som muligt.

* Huvis der kommer fremmed substans eller
vand ind i skaeermen, sa sluk straks for
stremmen og tag stikker ud. Fjern derefter
den fremmede substans eller vandet, og
send skaermen til servicecenteret.

* Skeermen ma ikke bruges eller opbevares pa
steder, hvor den udsattes for varme, direkte
sollys eller ekstrem kulde.

* For at opretholde den bedste ydelse
af din skeerm og for langvarig brug,
bedes du bruge skermen et sted, der



er indenfor fglgende temperatur- og
fugtighedsomrade.

* Temperatur: 0-40°C 32-95°F
*  Fugtighed: 20-80 % RH

Vigtige oplysninger om fastbraendte billeder/
spogelsesbilleder.

Serg altid for at aktivere en pauseskarm,
der beveager sig, nar skermen efterlades
uden at blive anvendt. Du skal altid bruge
en pauseskaerm eller et andet program,
der opdaterer skeermen regelmassigt,
hvis skaeermen viser statisk materiale

i llengere perioder. Uafbrudt visning

af et stilbillede over lengere tid, kan
forarsage “brandmaerker”, ogsa kendt som
“efterbilleder” eller “spagelsesbilleder” pd
skaermen.

“Breendmeerker”, “efterbilleder”, og
“spogelsesbilleder” er et velkendt
fenomen i LCD skaermteknologi. | de
fleste tilfelde vil “brandmerkerne” eller
“efterbilledet” eller “spggelsesbilledet”
forsvinde gradvist, efter skeermen er
blevet slukket.

O Advarsel

Hvis der ikke aktiveres en pauseskarm eller
et program til periodisk skaermopdatering, kan
det resultere i alvorlige “fastbreendinger” eller
“efterladte billeder” eller "spagelsesbilleder”,
hvis symptomer hverken forsvinder eller kan
repareres. Ovenstaende skade daekkes ikke af
garantien.

Service

Kabinettet ma kun abnes af kvalificeret
servicepersonale.

Hvis der er behov for et dokument til
reparation eller integration, sd kontakt
dit lokale servicecenter. (Se kapitel om
“Kundeinformationscenter”)

For oplysninger om transport, se
“Tekniske specifikationer”.

Efterlad ikke din skeerm i en bil/bagagerum
under direkte sollys.

& Bemerk

Kontakt en servicetekniker; hvis skaermen ikke
fungerer korrekt, eller hvis du er usikker pa,
hvad du skal gare, ndr betjeningsinstruktionerne,
der er givet i denne manual, er fulgt.



1.2 Notationsbeskrivelser

Folgende underafsnit beskriver de
notationsmassige konventioner, der benyttes i
dette dokument.

Bemaerkninger, forholdssregler og advarsler

| hele denne vejledning kan tekstafsnit vaere
ledsaget af et ikon, og sta med fed eller kursiv
skrift. Disse afsnit indeholder bemaerkninger og
punkter, hvor der skal udvises forsigtished, eller
advarsler. De anvendes som falger:

& Bemerk

Dette ikon angiver vigtige oplysninger og
tips, hvormed du kan ggre bedre brug af
computersystemet.

o Forsigtig

Dette ikon angiver oplysninger om, hvordan du
undgar risiko for skader pa hardwaren eller tab
af data.

O Advarsel
Dette ikon angiver risiko for personskader, og
hvordan dette undgas.

Visse advarsler kan optrede i andre formater,
og er eventuelt ikke ledsaget af et ikon. |
sadanne tilfelde er den givne udformning af
advarslen lovmassigt obligatorisk.



1.3 Bortskaffelse af produkt og
emballage

Elskrot WEEE (Waste Electrical and Electronic
Equipment)

This marking on the product or on its
packaging illustrates that, under European
Directive 2002/96/EC governing used electrical
and electronic appliances, this product may
not be disposed of with normal household
waste.You are responsible for disposal of

this equipment through a designated waste
electrical and electronic equipment collection.
To determine the locations for dropping off
such waste electrical and electronic, contact
your local government office, the waste disposal
organization that serves your household or the
store at which you purchased the product.

Your new monitor contains materials that can
be recycled and reused. Specialized companies
can recycle your product to increase the
amount of reusable materials and to minimize
the amount to be disposed of.

All redundant packing material has been
omitted. We have done our utmost to make the
packaging easily separable into mono materials.

Please find out about the local regulations
on how to dispose of your old monitor and
packing from your sales representative.

Taking back/Recycling Information for
Customers

Philips establishes technically and economically
viable objectives to optimize the environmental
performance of the organization's product,
service and activities.

From the planning, design and production
stages, Philips emphasizes the important of
making products that can easily be recycled. At
Philips, end-of-life management primarily entails
participation innational take-back initiatives

and recycling programs whenever possible,
preferably in cooperation with competitors,
which recycle all materials (products and
related packaging material) in accordance with
all Environmental Laws and taking back program
with the contractor company.

Your display is manufactured with high quality
materials and components which can be
recycled and reused.

To learn more about our recycling program
please visit

http://www.philips.com/sites/philipsglobal/
about/sustainability/ourenvironment/
productrecyclingservices.page



; B4 Installation af stander
2. Opsatnlng af skaerm 1. Anbring skeermen med forsiden vendt

nedad pa en blgd og jeevn overflade, og veer
forsigtig med ikke at ridse eller beskadige
skaermen.

2.1 Installation

(1] Emballagens indhold 2. Fastger fodsgjlen pa skaermen, sa den laser
sig selv pa plads.

3. Hold pa skermens stander med begge
heender, og seet med en fast hand standeren
ind i fodsgjlen.

VGA (valgfri) DVI (valgfri)



Bl Tilslutning til PC

PHILIPS

@ AC stromindgang
© \/GA-indgang

© DVI-D-indgang (tilgengelig pa udvalgte

modeller)

O Lyd-indgang (tilgengelig pa udvalgte

modeller)
© Kensington anti-tyverisikring

Tilslutning til pc

2.2 Brug af skeerm

El Produktbeskrivelse set forfra

(

PHILIPS

00000

a1

|

Model 220V4LA:

1. Tilslut ledningen ordentligt pa bagsiden af
skaermen.

2. Sluk for computeren og tag netledningen
ud af stikket.

3. Slut skeermens signalkabel til videostikket
bag pa computeren.

4. Seet computerens og skaermens
netledninger til et stik i nerheden.

5. Teend for computeren og skaermen. Hvis
skeermen viser et billede, er installationen

gennemfort.

154
AUTO/Y (/A O-/4  B/0K O]
| | [\ | |
7 (6 (2] o
Model 220VA4L:
15
AU|TO/V [?]/A @fOK (||)
7] (6] (2] o
Q@ O |Tender og slukker for skermen.
Sadan far du adgang til OSD-
menuen.
® B/0K Bekreeft justering af
skeermmenuen.
G4 tilbage til det forrige OSD-
o < niveau.
(4 O-  |Justerer lysstryken.
© | A V¥V [Tiljustering i skermmenuen.
o 1l |Juster lydstyrken.
Ol |Skifter skeermformat.
@ AUTO |Juster skeermen automatisk.




2. Opsatning af skerm

E1 Beskrivelse af OSD-visningen

Hvad er OSD (On-Screen Display)?

Visning pa skeermen [On-Screen Display
(OSD)] er en funktion pa alle Philips LCD
skerme. Den satter en slutbruger i stand

til at justere skaermindstillingerne, eller

veelge skermens funktioner direkte via et
instruktionsvindue pa skaeermen. Et brugervenligt
skaermvisningsinterface vises som nedenfor:

Model 220V4LA:

o VGA ¢
& Input w .

Grundlazggende og enkle anvisninger til
kontrolknapperne

| skeermmenuen ovenfor, kan du bruge

V¥ A knapperne foran pa skeermen til at flytte
markeren med, og tryk pd OK knappen, til at
bekrafte dit valg eller eendring.

OSD-menuen

Nedenstdende er en generel oversigt over
strukturen i OSD-displayet. Du kan anvende
den som opslag, ndr du senere skal orientere

dig i de forskellige justeringer.

Main menu Sub menu

VGA
— Input I:
DVI

(available for selective models)

r— Picture Format
Picture

— Brightness

— Contrast

— SmartContrast

— Stand-Alone
Audio

— Mute

(available for selective models)

Color Temperature

Wide Screen, 4:3
0~100

0~100

On, Off

On, Off

On, Off

6500K, 9300K

Color
sRGB
User Define Red: 0~100
Green: 0~100
Blue: 0~100
Language — English . Espafiol, Frangais, Deutsch, Italiano,

Portugués, Pycckuin, TEIfERHISE, Tirkge

— Horizontal
OSD Settings
— Vertical

— Transparency

— OSD Time Out

Setup — Auto
— H. Position
— V. Position

— Phase

— Clock

— Reset

L Information

— Resolution Notification

0~100
0~100
Off, 1,2, 3,4

5s, 10s, 20s, 30s, 60s

— 0~100
— 0~100
— 0~100
— 0~100
— On, Off

— Yes, No



El Meddelelse om oplasning

Denne skaerm er fremstillet til optimal ydelse
pa dens native oplgsning, som er 1680 x 1050
@ 60 Hz. Nar skeermen bruger en anden
oplasning, ses falgende advarsel pd skaermen:
Brug 1680 x 1050 @ 60 Hz for at opna det
bedste resultat.

Advarslen vedrgrende den naturlige oplasning
kan deaktiveres under Setup (Installation) i
OSD (skaermmenuen).

4 Fysisk funktion
Vip

2.3 Fjern standeren og foden

1 Fjernelse af foden

Inden du begynder at adskille skaermens fod,
skal du felge vejledningerne nedenfor for at
undgd mulig beskadigelse eller personskade.

1. Anbring skeermen med forsiden vendt
nedad pa en jevn overflade, og veer
forsigtic med ikke at ridse eller beskadige
skaermen.

2. Tryk pa laseklemmerne for at fierne foden
fra sgjlen.




2. Opsatning af skaerm
© Bemarkning

Denne skaerm accepterer et 100 x 100 mm
VESA-kompliant monteringsinterface.




3. Billedoptimering

3.1 SmartContrast .

El Hvad er dette?

Unik teknologi, der dynamisk analyserer det
viste indhold, og automatisk optimerer LCD
skermens kontrastforhold til maksimal visuel
klarhed. Den gger baggrundsbelysningen og
giver et klarere, friskere og lysere billede eller
demper baggrundsbelysningen med henblik
pa en tydelig visning af billeder pa en mark
baggrund.

Bl Hvorfor behaver jeg det?

Du gnsker den allerbedste visuelle klarhed
og visning pa enhvert indhold. Smart-kontrast
styrer den dynamiske kontrast og indstiller
baggrundslyset, sa det giver klare, friske og
lyse spil- og videobilleder, samt viser en
tydelig, lesbar tekst ved kontorarbejde.Ved at
nedsatte skeermens strgmforbrug, sparer du
energiomkostninger og forleenger skaermens
levetid.

El Hvordan virker det? .
Nar du aktiverer SmartContrast, analyseres

det viste indhold i realtid, og farver og .
baggrundslysets intensitet indstilles. Denne

funktion forbedrer den dynamiske kontrast og .

giver sdledes en bedre underholdningsoplevelse,
nar du ser videoer eller spiller spil.

3.2 Philips SmartControl Lite

Det nye SmartControl Lite-software fra Phillips
giver dig mulighed for at kontrollere skeermen
via et nemt, grafisk interface. Komplicerede
justeringer hgrer fortiden til. Dette
brugervenlige software guider dig gennem
finindstilling af opl@sning, kalibrering af farve,
justering af clockning/fase, RGB-hvidpunkt osv.

Dette igjefaldende, ikon-baseret software er
udstyret med den seneste teknologi I algoritmer
for hurtig behandling og reaktion, og er tilmed

10

Windows / kompatibel, og klar til at forbedre
din oplevelse med Philips-skaerme!

Installation

Folg instruktionen og fuldfer installationen.
Du kan starte, nar installationen er fuldfert.
Hvis du vil begynde senere, kan du klikke

pa genvejen pa skrivebordet eller pa
veerktgjslinjen.

PHILIPS

www.philips.com/welcome

Monitor driver and software installation
Spstarm reqursments:
« PC running Windews 7, Vista, XF, 3000, 98,

» Go to waw.philips.comiwelcome 1o downlaad the latest version of moritor driver

Philips SmartControl
System swpport and requirements:
1. System support Windows 7, Vista, XP.

2 Langusge swpport Englsh, German, Spanish, French, Inalian, Russian, Portuguese, Simplified Chinase
3. Philips Monécor Plug and Play suppost.

Opstartsguide

Efter installation af SmartControl Lite
starter Wizard (guiden) automatisk, nar du
dbner programmet fgrste gang.

Guiden leder dig trin for trin gennem
indstillingen af skeermen.

Du kan ogsa ga til Plug-in menuen, for at
starte guiden pa et senere tidspunkt.

| Standard-vinduet kan du indstille flere
funktioner uden brug af guiden.



3. Billedoptimeri

[; B SmartControl 2 - Philips 22581 (Cs30715000001) (7 _25.
SmartControl Lite PHILIPS

Wizard

You'll need to calibrate your display to get: the most
accurate color. We encourage you to use the simple
‘tuning process by selecting the Start Wizard button.
This process involves 3 series of steps that wil let you
tune your display and save the settings.
1. Choose the Start Wizard button.
2. Follow the steps outined in this process.
- 3. Save your settings for future use.
Adjust Audio

Auto Pivot

T
Input

Wizard
Presets
Multi Monitors

Start Wizard

F1 Start med Standard-vinduet:

Adjust menu (Indstillingsmenu):
* Med Adjust Menu (Indstillingsmenuen)
kan du indstille Brightness (Lysstyrken),

Contrast (Kontrast), Focus (Fokus), Position

(Position) og Resolution (Oplasning).

» Udfer indstillingen ved at folge
instruktionerne.

e [nstallationen kan annulleres med Cancel
(Annuller).

@ B SmartControl 2 - Philips 22581 (€530715000001) | ?)(X)
SmartControl Lite PHILIPS

Brightness

Improperly adjusted Brightness wil resuft in a loss of
detai in darker image areas. Adjust the Brightness for
the best possible picture qualty.

1. Lower the Brightness to the minimum level.
2. Raise the Brightness to the desired level.
3. Adjust the Brightness as needed to achieve
an equal separation of the stripes.
Adiust

=t Focus Brightness 100
= O

Undo Reset.

Resolution

Help

" | SmartControl

SmartControl Lite

i

Adijust )

Brightness

Contrast

a
%

Color

B

By
&
2

- osition
‘Options FF
g Resolution
Help
B smartcontrol
SmartControl Lite
Adjust Q
Brightnass

o

Contrast

* s

o Focus
N
Position
Options ?F
Resolution

" | SmartControl

SmartControl Lite

=
=

Color ~a

~
Focus

Brightness

Cd

Contrast

Posttion

"

Resolution

2 - philps 22581 (CS30715000001) {¥}(X)

PHILIPS

Contrast

Adjust the Contrast (use the siider) to keep details in
lighter image areas.
1. Raise the Contrast until the numbers 1 and 2
are no longer visible.
2. Slowly lower the Contrast to make the
numbers 2 and 3 reappear. The number 1
should remain barely visble.

Contrast 50

(+

Undo Reset

2 - Philips 22581 (CS30715000001) § ¥} %)

PHILIPS

Focus

Your display's timing needs to be synchronized with
the video signal.

1. Choose Auto Setup.

2. If the vertical bands are stil visble, you'l need

to adjust the Pitch.

Pitch: Try to make the vertical bands disappear.
Phase: Adjust to the brightest setting to minimize
movement on the screen.

Pitch 50
o - &)
Phase 17
o ~ &
undo AUto Setup
2 - Philips 22581 {€S30715000001) i X
Position

Use the Pesition buttons to center the image on
your display. Using this taol, you can posttion the image
up, down, left, or right.

1. Use the Up/Down buttons to center the image

verticaly.
2. Use the Left/Right buttons to center the image
horzontaly.
Undo Reset




3. Billedoptime

-
W SmartControl

SmartControl Lite

Adjust Q
Brightness
o !
Contrast
Color
Focus

Position

Options ﬁ
Resolution

Help

2 - Phiips 22581 (€S30715000001) ('F] (%)
PHILIPS

Resolution

You are currently at a Preferred resolution. For your
display to show crisp, clear text, colors, and images,
your display should be set to its Preferred resolution.

If your display is at a Non-Preferred resolution, click
on the Preferred button to change your resolution to
Prefarred.

™ Enable Resolution Notifier

Picture Format
™ 4:3 aspect ratio

Preferred

Color menu (Farvemenu):

* Med Color Menu (Farvemenuen) kan du
indstille RGB, Black Level (Sortniveau),
White Point (Hvidpunkt), Color Calibration

(farvekalibrering).

» Udfer indstillingen ved at folge

instruktionerne.

* Se nedenstdende oversigt med
undermenupunkter baseret pa din

indtastning.

*  Eksempel pa Color Calibration

(farvekalibrering):

@ smartControl

SmartControl Lite

White Point

“
Display Garmma
)

Calibration

Help

2 - Phiips 22561 (Cs30715000001) {F)i%) §

e

PHILIPS

Black Level

Improperly adjusted Black Level will result in 2 loss of
detailin darker image areas. Adjust the Black Level for
the best possile picture quality.
1. Adjust the black level of the Red, Green, and
Biue using the slider bars.

Red 50

= o &

Green 50

=] o &7

Blue 50

= C© =7
Undo Reset

12

|8 smartControl

SmartControl Lite

i B St Contiol

"

RGB
Blac!« Level

wh Ie Point

Display Garnma

wyl

Calbration

SmartControl Lite

Adjust

Options

B SmartControl

SmartControl Lite

—

RGR
Dh! Level
White Point

Display Garrera

2 - philps 22581 (Cs30715000001) {F](X) §

PHILIPS

White Point

White Point is the point at which equal combinations
of red, green, and blue light at full intensity create
white. This effects the overall color quality. For the
most accurate colors click the Reset button then
select the White Paint.

1. Please select the White Point value for the best
possible color guality.

White Point 6500K
= © 5}
Undo Reset

2 - Philps 22581 (C530715000001) 1 X

PHILIPS

Display Gamma

righter pixek:
s datkor piosk. The

and a higher Garnera vakis
dofault vaikan For Garmra b 2.2,

To adjust Garrre, Serurt g
Cick ths SrrurtTruager (4F bt
Garnima.

i, Use the sider to select the desred Gamma.

Disptay Gamma

|
(
&

Unda Reset

2 - Philps 22581 (C530715000001) (3] 5-
PHILIPS

Calibration

Your deplay needs to be propery calibrated in order
for & to produce the widest range of colors accurately.
Calibration should abways take place as the bst tuning
step In the process. Remember to recalbrate any tme
vou make individual adjustments to image qualty or
whenever you move your display to 2 new lacation.

1. Mzke al other necessary adjustments to mage
qualty first.

2. Press Show Me to leam how to use the
calibration took.

3. Finaly, press Start to begn the calibration
process.

¥ Enable color calbration

Calor software designiee in colabaration with Jaseph
Halmes.

Pratected by U.S. Patent No. 6,686,953

Show Me Start.

Quick View



3. Billedoptimering

AN

“Show Me" (Vis Mig) starter vejledningen til
farvekalibrering.

Start — starter en 6é-trins
farvekalibreringssekvens.

Quick View (Hurtigvisning) indleeser far/
efter-billederne.

For at vende tilbage til Color (Farve)

vinduet, skal du klikke pa Cancel (Annuller).

Enable color calibration (Aktiver
farvekalibrering) - der som standard er
aktiveret. Hvis markeringen er fiernet, kan
du ikke udfgre en farvekalibrering, ligesom
start- og quick-visning knapperne er
gratonede.

Der skal vere patentoplysninger pa
kalibreringsskaermen.

Forste farvekalibreringsskaerm:

Previous (Foregdende) knappen er
deaktiveret, indtil du gar videre til den
anden farveskaerm.

Next (Neeste) gar til efterfelgende mal
(seks mal).

Ga til sidst til File > Presets (File > Forvalg)
vinduet.

Cancel (Annuller) lukker Ul og vender
tilbage til plug in siden.

13

Options > Preferences (Funktioner >
Indstillinger) - er kun aktiv, ndr Preferences

(Indstillinger) er valgt i Preferences (Funktioner)-

rullemenuen. Pa en ikke-understattet skaerm
med DDC/CI er kun Help (Hjaelp) og Options
(Funktioner) til radighed.

" 8 SmartControl

SmartControl Lite

\g 2
{

2

o

2 - Philps 225B1 (C530715000001) i 5’ ]

PHILIPS

Preferences

Set Transparency:

Pre!ren ces
udio

Q

>

Aufe

(=]
=

Adjust
Color Tnput
ey
Options
‘g Multi Monitors
Help

Viser nuvaerende, foretrukne indstillinger.

Funktionen aktiveres ved at afmearke feltet.
Afmaerkningsfeltet er en flip-flop.

Enable Context Menu (Aktivér Indhold
menuen) er som standard afmeerket

(Til) pa skrivebordet. Enable Context
Menu (Aktivér Indhold menuen) viser
valgmulighederne i SmartControl Lite

pa Select Preset (Velg Forvalg) og Tune
Display (Indstil Display) i genvejmenuen
ved at hgjreklikke pd skrivebordet. Disabled
(Deaktiveret) fierner SmartControl Lite fra
genvejsmenuen.

Enable Task Tray (Aktiver Jobbakke)
menuen er som standard afmaerket

(Til) pa skrivebordet. Enable Context
Menu (Aktivér Indhold menuen) gar, at
systembakkens ikon til SmartControl Lite
vises. Et hgjreklik pa jobbakke-ikonen

viser menufunktionerne for Help (Hjeelp),
Technical Support (Teknisk Support), Check
for Update (Tjek for opdateringer), About
(Om) og Exit (Afslut). Nar Enable Task Tray
(Aktiver Jobbakke) menuen er deaktiveret,
viser jobbakke-ikonen kun EXIT (AFSLUT).



3. Billedoptimering

* Run at Startup (Ker ved opstart) er Options > Audio (Funktioner > Lyd) - er
som standard afmaerket (Til). Ndr den kun aktiv, nar Audio (Lyd) er valgt i Options
er deaktiveret, starter SmartControl Lite (Funktioner) rullemenuen.

ikke ved opstart og ikonet vises ikke |
systembakken. SmartControl Lite kan
kun startes fra genvejen pa skrivebordet

Pa en ikke-understattet skeerm med DDC/CI
er kun Help (Hjelp) og Options (Funktioner) til

radighed.
eller fra programfilen. Intet forvalg, som er &
indstillet til at kgre ved opstart, indleeses kil Zn e ) a
SmartControl Lite PHILIPS

nar denne boks ikke er afmerket (er
deaktiveret). Audio

Adjust the Volume of the integrated loudspeakers by

» Enable transparency mode (Aktivér e e
gennemsigtighedstilstand) (Windows U e
7,Vista, XP). Standard er 0% — Q
uigennemsigtighed. — ‘

Options > Input (Funktioner > Indgang) Cobr Pt

- er kun aktiv, nar Input (Indgang) er valgt i ¥ E

Options (Funktioner) rullemenuen. Pa en ikke- \% 2

understattet skeerm med DDC/CI er kun Help wt

Multi Monitors

(Hjeelp) og Options (Funktioner) til radighed.

&

Alle andre faneblade i SmartControl Lite er ikke Help P ®
til rddighed. undo
" | SmartControl 2 - Philps 22581 (CS30715000001) {¥]|X, .
SmartControl Lite PHILIPS Help > User Manual (Hjlp >
; Brugervejledning) - er kun aktiv, nar User
nput . . .
e Manual (Brugervejledning) er valgt i Help
at the same time. Use the Analog In and Digital In . o .
» buktans o slct which st youd et . You (Hjelp) rullemenuen. P4 en ikke-understattet
u g e g skeerm med DDC/Cl er kun Help (Hjelp) og
Adijust o may have to use the Input Select button on the front . . . -
N Ald I Options (Funktioner) til radighed.
D e B smariControl 2 - Philips 22581 (€530715000001) ()X
- .
e Ao SmartControl Lite PHILIPS
' 4+ ';
\Q izl User Manual
L You can also choose to have infarmation about your

software automatically attached to the assistance

Multi Monitors "
form. You'll need to be online to use this feature.

M
"

Adjust
Help
User Manual

Analog In Digital In \g ".;J
Update
Calor
* Vis Source (Kilde) instruktionsvinduet og g
nuvaerende indgangskildeindstillinger. \g 9,
) . Option
* P4 enkeltindgangsskeerme ses dette vindue .4

ikke.

P

User Manual Tach. Support
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3. Billedoptimering

Help > Version (Hjalp > Version) - er kun aktiv,
narVersion (Version) er valgt i Help (Hjzelp)
rullemenuen. Pa en ikke-understattet skeerm
med DDC/Cl er kun Help (Hjzlp) og Options
(Funktioner) til radighed.

T SmartControl 2 - Philps 22581 (CS30715000001) {F}X,
SmartControl Lite PHILIPS

Version

SrrartControl

Version 0.00 EVALUATION dtune-pip-R2009-12-17-
1913-04

DDC/CI Communication: Yes - ATI2 AP

Copyright © 1993-2009 Partrait Displays, Inc.
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Options

Context Sensitive (Indholdssensitiv) menuen

Context Sensitive (Indholdssensitiv) menuen
er som standard aktiveret. Hvis Enable Context
(Aktiver Indholdssensitiv) menuen er afmeerket
| Options > Preferences (Funktioner >
Indstillinger) vinduet, ses menuen.

ﬁ SmartControl
Select Preset 4
Tune Display

”Context” (Indhold) menuen har tre punkter:

*  SmartControl Lite - ndr valgt, ses About
(Om) skaermen.

* Select Preset (Velg Forvalgt) — herefter
vises en hierakisk menu med gemte forvalg,
der straks kan bruges. En afkrydsning viser
det nuveerende valgte forvalg. Factory
Preset (Fabriksforvalg) kan ogsa hentes i
rullemenuen.

* Tune Display (Indstil Skeerm) - abner
kontrolpanelet til SmartControl Lite.

Task Tray (Jobbakke) menu aktiveret
Menuen | systembakken kan ses ved at
hojreklikke pd SmartControl Lite-ikonet
I systembakken. Et venstreklik starter
programmet.

Help

Technical Support
Check for Update
About

Exik

Jobbakken har fem punkter:

* Help (Hjzlp) - adgang til
brugervejledningsfilen: Abner User Manual
(Brugervejledningen) med standard
browservinduet.

* Technical Support (Teknisk Support) - viser
siden med teknisk support.

» Check for Update (Tjek for opdateringer)
- leder brugeren til PDI Landing og tjekker
brugerens version i forhold til den nyeste
version.

* About (Om) - viser detaljerede
referenceoplysninger: Produktversion,
udgivelsesinformation og produktnavn.

* Exit (Afslut) - Luk SmartControl Lite.
Hvis du vil kere SmartControl Lite igen,
skal du enten valge SmartControl Lite i

programmenuen, dobbeltklikke pa skrivebordet
eller genstarte systemet.

SmartControl

PHILIPS

EmartControl
‘ersion 3.20
ctune-standard-R2007-01-04-1151-23
Copyright 1983-2007 Portrait Displays, Inc.
Patents Pending




Task Tray (Jobbakke) menu deaktiveret

Nar Task Tray (Jobbakke) er deaktiveret i
indstillinger-mappen, er kun EXIT (AFSLUT)
valgmuligheden til radighed. Hvis du helt vil
flerne SmartControl Lite fra systembakken,

skal du deaktivere Run at Startup (Ker ved
opstart) i Options > Preferences (Muligheder >
Indstillinger).

16



4. Tekniske specifikationer

Skarmpaneltype TFT-LCD

Baggrundslys LED

Panelstorrelse 22" W (559cm)

Billedforhold 16:10

Pixel pitch 0,282 x 0,282 mm

Lysstyrke 250 cd/m?

Smart-kontrast 10,000,000:1

Kontrastforhold (norm.) 1000:1

Reaktionstid (norm.) 5ms

Optimal opl@sning 1680 x 1050 pd 60 Hz

Synsvinkel 170° (H) / 160° (V) ved C/R > 10

Skeermfarver 16,7 M

Vertikal opdateringshastighed 56Hz - 76Hz

Horisontal frekvens 30kHz - 83kHz

sRGB JA

Inputsignal DVI (digital), VGA (Analog)

Inputsignal Separat synk., synk. pa gren

Brugerfunktioner ZA0RLS - AU/ '4/A 0/4 /eI O
220v4L: auto/v  EO/A -/ 4 /0K 0)

Engelsk, Fransk, Tysk, Spansk, Italiensk, Russisk,

OSD sprog Simplificeret Kinesisk, Portugisisk og Tyrkisk
Andre funktioner Kensington-1as
"Plug & Play" kompatibilitet DDC/CI, sRGB, Windows 7/Vista/XP Mac OSX,; Linux
Vip -5/ +20
220V4LA:
Teendt-tilstand 23,3W (typ.), 26,8W (maks.)
| dvale (Standby) 0,5W
Fra 0,5W
Strgmdiode Til-tilstand: Hvid, standby-/sove-tilstand: Hvid (blinker)
Stremforsyning Indbygget, 100-240VAC, 50-60Hz
220VA4L:
Teendt-tilstand 20,68W (typ.), 24,26W (maks.)
| dvale (Standby) 0,5W

17



Fra

0,5W

Strgmdiode

Til-tilstand: Hvid, Standby-/Sove-tilstand: Hvid (blinker)

Stremforsyning

Indbygget, 100-240VAC, 50-60Hz

Produkt uden fod (B x H x D) 512 x 416 x 213 mm

Produkt uden fod (B x H x D)

512 x 348 x 48 mm

Myndighedernes godkendelser

Produkt med fod 3.660kg

Produkt uden fod 3.320kg

Produkt med emballage 4.860kg

Temperaturomrade (drift) 0°C til 40°C

Temperaturomrade (ikke i drift) | -20°C til 60°C

Relativ fugtighed 20% til 80%

MTBF 30.000 timer
Miljomassige forhold

ROHS JA

EPEAT Silver (www.epeat.net)

Emballage 100 % genbrugelig

Specifikt hovedindhold 100% PVC BFR-fri kabinet

Energy Star JA

CE Meerket, FCC Klasse B, GOST, SEMKO, TCO Godkendt (Only
for selective models), UL/cUL, 1509241-307,BSMI

Farve Sort
Overflade Blank/Tekstur
@ Bemark

1. EPEAT Gold og Silver er kun gyldig hvor Philips registrer produktet. Besgg venligst www.epeat.net

for registreringsstatus i dit land.

N

version af brochuren.

Disse data kan andres uden varsel. Ga til www.philips.com/support for at hente den seneste

18



4.1 Oplasning og forudindstillede
funktioner

Bl Maksimal oplesning
1680 x 1050 ved 60 Hz (analogt indgang)
1680 x 1050 ved 60 Hz (digital indgang)

Bl Anbefalet opla@sning
1680 x 1050 ved 60 Hz (digital indgang)

31,47 720 x 400 70,09
31,47 640 x 480 59,94
35,00 640 x 480 66,67
37,86 640 x 480 72,81
37,50 640 x 480 75,00
37,88 800 x 600 60,32
46,88 800 x 600 75,00
48,36 1024 x 768 60,00
60,02 1024 x 768 75,03
44,77 1280 x 720 59,86
63,89 1280 x 1024 60,02
79,98 1280 x 1024 75,03
55,94 1440 x 900 59,89
70,64 1440 x 900 74,98
65,29 1680 x 1050 59,95

& Bemark

Bemeaerk venligst at din skaerm virker bedst med
native oplasning pa 1680 x 1050 ved 60Hz. For
at opna den bedste skeermkvalitet, bedes du
venligst bruge denne oplgsning.

19



5. Stremstyring

Hvis der er installeret et skaermkort eller
software pa pc'en, der er i overensstemmelse
med VESA DPM, kan skermen automatisk
nedsatte strgmforbruget, nar den ikke bruges.
Nar input fra tastatur, mus eller anden input-
enhed registreres, "vagner" skeermen automatisk
igen. Nedenstaende tabel viser denne
automatiske energisparefunktions strgmforbrug
og signalering:

220V4LA:

VESA

tilstand Video | V synk | L synk | Opbrugt strem | LED Farve

Aktiv TIL Ja Ja 23,3W (norm.) Hvid

| dvale : : Hvid
(Standoy) | T4 | NN OOWIOR) ey
Kontakt Fra| FRA = = 0,5W (typ.) FRA
220V4L:
VESA :
dlsang | Video [ Vsynk | Lsynk | Opbrugt strem | LED Farve

Aktiv TIL Ja Ja 20,68W (norm.) Hvid

| dvale : : Hvid
(Standby) | A | Nei | Nel 05W (trp) (blinker)
Kontakt Fra| FRA - - 0,5W (typ.) FRA

Folgende opsatning bruges til at mdle
skeermens stremforbrug.

* Indbygget oplasning: 1680 x 1050
* Kontrast: 50%
*  Lysstyrke: 250 nits

* Farvetemperatur: 6500k med fuldt, hvidt
manster

@ Bemark
Disse data kan a&ndres uden varsel.

20



6. Lovmassige oplysninger

Lead-free Product

Lead free display promotes
environmentally sound recovery

& and disposal of waste from electrical
and electronic equipment. Toxic
substances like Lead has been eliminated

and compliance with European community’s
stringent RoHs directive mandating restrictions
on hazardous substances in electrical and
electronic equipment have been adhered to

in order to make Philips monitors safe to use
throughout its life cycle.

Congratulations!

This display is designed for both you and the
planet

The display you have just purchased
carries the TCO Certified label.

This ensures that your display is
designed, manufactured and tested according to
some of the strictest quality and environmental
requirements in the world. This makes for a high
performance product, designed with the user
in focus that also minimizes the impact on the
climate and our natural environment.

TCO Certified is a third party verified program,
where every product model is tested by an
accredited impartial test laboratory. TCO
Certified represents one of the toughest
certifications for displays worldwide.

Some of the Usability features of the TCO
Certified for displays:

*  Visual ergonomics for good image quality
is tested to ensure top performance and
reduce sight and strain problems. Important
parameters are luminance, contrast,
resolution, black level, gamma curve, colour
and luminance uniformity and colour
rendering.

*  Products are tested according to rigorous
safety standards at impartial laboratories.

21

 Electric and magnetic fields emissions as
low as normal household background
levels.

* Low acoustic noise emissions (when
applicable).

Some of the Environmental features of the
TCO Certified for displays:

* The brand owner demonstrates corporate
social responsibility and has a certified
environmental management system (EMAS
or ISO 14001).

* Very low energy consumption both in on-
and standby mode minimize climate impact.

* Restrictions on chlorinated and brominated
flame retardants, plasticizers, plastics and
heavy metals such as cadmium, mercury
and lead (RoHS compliance).

* Both product and product packaging is
prepared for recycling.

* The brand owner offers take-back options.

The requirements can be downloaded from our
web site. The requirements included in this label
have been developed by TCO Development in
co-operation with scientists, experts, users as
well as manufacturers all over the world. Since
the end of the 1980s TCO has been involved

in influencing the development of IT equipment
in a more user-friendly direction. Our labeling
system started with displays in 1992 and is now
requested by users and IT-manufacturers all
over the world. About 50% of all displays world-
wide are TCO certified.

For more information, please visit:
www.tcodevelopment.com

TCOF1058 TCO Document,Ver. 2.1

I[n Technology for you and the planet
CERTIFIED

(Only for selective models)




EPEAT

(Www.epeat.net)
Q The EPEAT (Electronic
W Product Environmental
Assessment Tool) program
evaluates computer
desktops, laptops, and monitors based on 51
environmental criteria developed through

an extensive stakeholder consensus process
supported by US EPA.

EPEAT system helps purchasers in the public
and private sectors evaluate, compare and
select desktop computers, notebooks and
monitors based on their environmental
attributes. EPEAT also provides a clear and
consistent set of performance criteria for the
design of products, and provides an opportunity
for manufacturers to secure market recognition
for efforts to reduce the environmental impact
of its products.

Benefits of EPEAT

Reduce use of primary materials
Reduce use of toxic materials

Avoid the disposal of hazardous waste EPEAT'S
requirement that all registered products meet
ENERGY STAR's energy efficiency specifications,
means that these products will consume less
energy throughout their life.

22

CE Declaration of Conformity

This product is in conformity with the following
standards

*  EN60950-1:2006 (Safety requirement of
Information Technology Equipment).

«  EN55022:2006 (Radio Disturbance
requirement of Information Technology
Equipment).

*  EN55024:1998+A1:2001+A2:2003
(Immunity requirement of Information
Technology Equipment).

«  EN61000-3-2:2006+A1:2009+A2:2009
(Limits for Harmonic Current Emission).

* EN61000-3-3:2008 (Limitation of Voltage
Fluctuation and Flicker) following provisions
of directives applicable.

»  2006/95/EC (Low Voltage Directive).

« 2004/108/EC (EMC Directive).

* 2005/32/EC (EuP Directive, EC No.
1275/2008 mplementing Directive
for Standby and Off mode power
consumption) and is produced by a
manufacturing organization on 1SO9000
level.

The product also comply with the following
standards

+ 1S09241-307:2008 (Ergonomic
requirement, Analysis and compliance test
methods for electronic visual displays).

*  GS EK1-2000:2009 (GS mark requirement).

*  prEN50279:1998 (Low Frequency Electric
and Magnetic fields for Visual Display).

*  MPR-II (MPR1990:8/1990:10 Low
Frequency Electric and Magnetic fields).

« TCO CERTIFIED (Requirement for
Environment Labeling of Ergonomics,
Energy, Ecology and Emission, TCO: Swedish
Confederation of Professional Employees)
for TCO versions.



Energy Star Declaration

(Www.energystargov)

As an ENERGY STAR® Partner, we
have determined that this product
meets the ENERGY STAR®
guidelines for energy efficiency.

ENERGY STAR

& Note

We recommend you switch off the monitor
when it is not in use for a long time.

Federal Communications Commission (FCC)
Notice (U.S. Only)

& This equipment has been tested and found
to comply with the limits for a Class B digital
device, pursuant to Part 15 of the FCC
Rules. These limits are designed to provide
reasonable protection against harmful
interference in a residential installation.

This equipment generates, uses and can
radiate radio frequency energy and, if not
installed and used in accordance with the
instructions, may cause harmful interference
to radio communications.

However, there is no guarantee that
interference will not occur in a particular
installation. If this equipment does cause
harmful interference to radio or television
reception, which can be determined by
turning the equipment off and on, the
user is encouraged to try to correct

the interference by one or more of the
following measures:

* Reorient or relocate the receiving antenna.

* Increase the separation between the
equipment and receiver.

» Connect the equipment into an outlet on
a circuit different from that to which the
receiver is connected.

» Consult the dealer or an experienced
radio/TV technician for help.

23

@ Changes or modifications not expressly
approved by the party responsible for
compliance could void the user's authority
to operate the equipment.

Use only RF shielded cable that was supplied
with the monitor when connecting this monitor
to a computer device.

To prevent damage which may result in fire or
shock hazard, do not expose this appliance to
rain or excessive moisture.

THIS CLASS B DIGITAL APPARATUS MEETS
ALL REQUIREMENTS OF THE CANADIAN
INTERFERENCE-CAUSING EQUIPMENT
REGULATIONS.

FCC Declaration of Conformity

Declaration of Conformity for Products Marked
with FCC Logo,

United States Only

FC

This device complies with Part 15 of the FCC
Rules. Operation is subject to the following two
conditions: (1) this device may not cause harmful
interference, and (2) this device must accept any
interference received, including interference that
may cause undesired operation.

Commission Federale de la Communication
(FCC Declaration)

& Cet équipement a été testé et déclaré
conforme auxlimites des appareils
numeériques de class B,aux termes de
I'article 15 Des regles de la FCC. Ces
limites sont concues de facon a fourir
une protection raisonnable contre les
interférences nuisibles dans le cadre d'une
installation résidentielle.

CET appareil produit, utilise et peut émettre
des hyperfréquences qui, si I'appareil n'est
pas installé et utilisé selon les consignes
données, peuvent causer des interférences
nuisibles aux communications radio.



6. Lovmassige oplysninge

Cependant, rien ne peut garantir I'absence
d'interférences dans le cadre d'une
installation particuliere. Si cet appareil est
la cause d'interférences nuisibles pour

la réception des signaux de radio ou de
télévision, ce qui peut étre décelé en
fermant I'équipement, puis en le remettant
en fonction, I'utilisateur pourrait essayer de
corriger la situation en prenant les mesures
suivantes:

* Réorienter ou déplacer 'antenne de
réception.

* Augmenter la distance entre I'équipement
et le récepteur.

*  Brancher I'équipement sur un autre circuit
que celui utilisé par le récepteur.

¢ Demander l'aide du marchand ou d'un
technicien chevronné en radio/télévision.

@ Toutes modifications n'ayant pas recu
I'approbation des services compétents
en matiere de conformité est susceptible
d'interdire a I'utilisateur I'usage du présent
équipement.

N'utiliser que des cables RF armés pour
les connections avec des ordinateurs ou
périphériques.

CET APPAREIL NUMERIQUE DE LA CLASSE
B RESPECTETOUTES LES EXIGENCES DU
REGLEMENT SUR LE MATERIEL BROUILLEUR
DU CANADA.
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EN 55022 Compliance (Czech Republic Only)

Thiz devica belongs to catagory B devices as described in EM 55022, unless it is spsacifi-
cally stated that it is a Class A device on the specification labal. The following applies to
devices in Class A of EN 55022 (radius of protection up to 30 meters). The ussr of the
device is obliged to taks all staps necessary to remove sources of intarfarence o tels-
communication or athar devices.

Pokud nani na typowam &tithu poditade uvedeno, 8 spada do do fidy A podis EN 55022,
spadd automaticky do tfidy B podie EN 55022, Pro zafizeni zatazrend do thidy A (chranné
péamo 30m) pedie EN 55022 platl nésledujicd. Dojde-ll k rufenl telekormumikatnich nabo
Fnich zafizeni je ufivatel povinnen prowdst takovd opatfgnl, aby rulieni odstranil.

Polish Center for Testing and Certification
Notice

The equipment should draw power from a
socket with an attached protection circuit (a
three-prong socket). All equipment that works
together (computer, monitor, printer; and so on)
should have the same power supply source.

The phasing conductor of the room's electrical
installation should have a reserve short-circuit
protection device in the form of a fuse with a
nominal value no larger than 16 amperes (A).

To completely switch off the equipment, the
power supply cable must be removed from the
power supply socket, which should be located
near the equipment and easily accessible.

A protection mark "B" confirms that the
equipment is in compliance with the protection
usage requirements of standards PN-93/T-42107
and PN-89/E-06251.

Wymagania Polskiego Centrum Badan i Certyfikacyi

Usradzeide powiano byd zasibane = galazds 2 preybacsnym obwodem ochronmym (gniasdo 2
kolkvenh, Wapdtpracugnce ze soby uresdeenia (komputer, monator, drokarkap powinny by msilome
# i sk rddla.

Instalacja elektrycoma pomieszceenta powine mwiesas w preewadsie Browym reeeraows achrong
proec] swarciami, w postaci bezprecenika o warkedcl mamionowe] me wigkszej nit 16A {amperew ).
W eelu catkowitego wylacrenia urzadeenta 2 siect zasilania, naledy wyjat wivezks kabla
sasllaigeego 2 gmazdka, kidre powlmnno ssjdowad s w pobliag ureadeenda 1 byd 2atwo dostgpie.

Znak berpicezefsiwa "B" potwiendea spodnost uresdrenia 2 wymaganiami beepiecefiuiwa
ukytkowanda yawartvitl w FR-UAT-H2107 1 PN-REAM2S].

Pozostale instrukcje bezpieczensiwa

* Mie maledy whwad wiyceek adaptenowvch lub wuwad kedka abwodi ochronnego = wiyceki.
Tedelt komsecene jest whycie preedbutacza e naledy whyd preediuiace 3-avlowego 2
prawidbowa polsceonymm preewodem ochmannym.

System kompulerowy naleky sabespieceyd preed naphyme, chwilowymi werostami lub spad-
kami napsgcia, wiywijae eliminatan preepies, urrasdzemia dopasawajacege leh
berraklaceniowegn Frodia easilania

Maleiy |||1vm|t sl albvy e o lekaloona kablsch systerni kull'qmll:uml.gfr arax aby kable me
byly umieszczone w |n||.| cu, gideie medna byloby na nie nadepiywad lub porylst sig o me.

* Mie maledy rozlewad napogia am meych plyaio s systeim kampubenowy.

Mie maleiy wpychal fadnveh preedmictio: do abwendw systenu kemputercwega, plyi moke
ta spowodowai pegar lub porasenie prydem, poprees swancie elemeniaw wewngirznych

- Syt kompulenowy powiiac enapdowad sl 2 dala od greejnikbo o deddel clepla. Porsdro,
re paledy blakawas atwerdw wentylacyjeych. Naledy unikac kladeensa luznpeh papseriw posd

kampriter sz amisseczania kampabera wociasnym migjsew bex mazliwass cyrkalacii powi-
elnm wokol nisgoe.



North Europe (Nordic Countries) Information

Placering/Ventilation

VARNING:

FORSAKRA DIG OM ATT HUVUDBRYTARE
OCH UTTAG AR LATATKOMLIGA, NAR
DU STALLER DIN UTRUSTNING PAPLATS,

Placering/Ventilation

ADVARSEL:

SORGVED PLACERINGEN FOR, AT
NETLEDNINGENS STIK OG STIKKONTAKT
ER NEMT TILGANGELIGE.

Paikka/llmankierto

VAROITUS:

SIOITA LAITE SITEN, ETTA VERKKOJOHTO
VOIDAAN TARVITTAESSA HELPOST]
IRROTTAA PISTORASIASTA.

Plassering/Ventilasjon

ADVARSEL:

NAR DETTE UTSTYRET PLASSERES, MA
DU PASSE PA AT KONTAKTENE FOR

STOMTILF@RSEL ER LETTE A NA.

BSMI Notice (Taiwan Only)
NELHENERIIEE
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Ergonomie Hinweis (nur Deutschland)

Der von uns gelieferte Farbmonitor entspricht
den in der "Verordnung Uber den Schutz vor
Schidden durch Rontgenstrahlen" festgelegten
Vorschriften.

Auf der Rickwand des Gerétes befindet sich
ein Aufkleber, der auf die Unbedenklichkeit der
Inbetriebnahme hinweist, da die Vorschriften
Uber die Bauart von Storstrahlern nach Anlage
Il @ 5 Abs. 4 der Rontgenverordnung erflllt sind.

Damit |hr Monitor immer den in der Zulassung
geforderten Werten entspricht, ist darauf zu
achten, daf3

1. Reparaturen nur durch Fachpersonal
durchgefihrt werden.
nur original-Ersatzteile verwendet werden.

3. bei Ersatz der Bildréhre nur eine
bauartgleiche eingebaut wird.

Aus ergonomischen Griinden wird empfohlen,
die Grundfarben Blau und Rot nicht auf
dunklem Untergrund zu verwenden (schlechte
Lesbarkeit und erhdhte Augenbelastung bei zu
geringem Zeichenkontrast waren die Folge).
Der arbeitsplatzbezogene Schalldruckpegel
nach DIN 45 635 betrdgt /0dB (A) oder
weniger.

7N ACHTUNG: BEIM AUFSTELLEN
DIESES GERATES DARAUF
ACHTEN, DAB NETZSTECKER UND
NETZKABELANSCHLURB LEICHT
ZUGANGLICH SIND.



6. Lovmassige oplysninge

China RoHS

The People's Republic of China released a
regulation called "Management Methods for
Controlling Pollution by Electronic Information
Products" or commonly referred to as China
RoHS. All products including CRT and Monitor
which are produced and sold for China market
have to meet China RoHS request.
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EU Energy Label

The European Energy Label informs you on
the energy efficiency class of this product.
The greener the energy efficiency class of this
product is the lower the energy it consumes.

On the label, you can find the energy efficiency
class, the average power consumption of

this product in use and the average energy
consumption for 1 year

&Note

The EU Energy Label will be ONLY applied on
the models bundling with HDMI and TV tuners.



/. Kundeservice og garanti

7.1 Philips' regler ved pixeldefekter
pa fladskerme

Philips tilstreeber at levere produkter af den
hgjeste kvalitet.Vi anvender nogle af branchens
mest avancerede produktionsprocesser og
udferer en streng kvalitetskontrol. En gang
imellem er defekte pixler eller sub-pixler pa
TFT-skeerme dog uundgdelige. Ingen producent
kan garantere, at alle paneler vil veere fri for
pixeldefekter, men Philips garanterer, at enhver
skeerm med et uacceptabelt antal defekter
repareres eller udskiftes under garantien.

Dette notat forklarer de forskellige former

for pixeldefekter og definerer de acceptable
defektniveauer for hver type. For at veere
berettiget til reparation eller udskiftning under
garantien skal antallet af pixeldefekter pa en TFT
-skeerm overskride disse acceptable niveauer.
For eksempel ma hgjst 0,0004% af sub-pixlerne
pa en skaerm veaere defekte. Desuden satter
Philips endnu hgjere kvalitetsnormer pa visse
typer eller kombinationer af pixeldefekter, der er
mere generende end andre. Denne pixelpolitik
gelder i hele verden.

4 N

sub-pixler sub-pixler

Vv
- J

Pixler og sub-pixler

sub-pixler

En pixel eller et billedelement er sammensat af
tre sub-pixler med primerfarverne red, gren og
bla. Nar mange pixler settes sammen, kan de
danne et billede. Nar alle sub-pixler i en pixel
lyser, fremstar de farvede sub-pixler tilsammen
som enkelt hvid pixel. Hvis de alle er marke,
fremstar de tre farvede sub-pixler tilsammen
som en enkelt sort pixel. Andre kombinationer
af oplyste og marke sub-pixler fremstar som
enkelte pixler i andre farver.
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Forskellige typer pixeldefekter

Pixel- og sub-pixeldefekter optreeder pa
skeermen pa forskellige mader. Der er to
kategorier af pixeldefekter og flere typer sub-
pixeldefekter i hver kategori.

Defekte lyse prikker

Defekte lyse prikker fremkommer som pixels
eller underpixels, der altid lyser eller er “teendt’.
Det vil sige, at en lys prik er en underpixel, der
fremstar pa skaermbilledet, nar skaermen viser et
merkt menster. Der er fglgende typer defekte
lyse prikker.

s R

o %

En teendt red, gren eller bla sub-pixel.
s N

l ¢

o %

To sammenliggende teendte sub-pixler:
- Red + Bla = Lilla
- Red + Grgn = Gul

- Gren + Bla = Cyan (Lysebld)
s B

o v

Tre sammenliggende tendte pixler (en hvid
pixel).



@ Bemaerk

En red eller bla lys prik skal vaere mere end 50
procent lysere end de omkringliggende prikker,
mens en gren lys prik er 30 procent lysere end
de omkringliggende prikker.

Defekte morke prikker

Defekte marke prikker fremkommer som
pixels eller underpixels, der altid er merke
eller er “slukkede”. Det vil sige, at en lys prik er
en underpixel, der fremstar pa skaermbilledet,
nar skaermen viser et merkt menster. Der er
felgende typer defekte marke prikker.

4 I N

-

-

Taetsiddende pixeldefekter

Da pixel- og sub-pixeldefekter af samme
type, der ligger teet pa hinanden, kan veere
mere igjnefaldende, specificerer Philips ogsa
tolerancer for teetsiddende pixeldefekter.

-

a N

- /

&

Pixeldefekttolerancer

For at veere berettiget til reparation eller
udskiftning pa grund af pixeldefekter i
garantiperioden skal en TFT-skaerm i en Philips
fladskeerm have pixel- eller sub-pixeldefekter,
der overskrider de tolerancer, der er gengivet i
folgende tabeller.

BRIGHT DOT-DEFEKTER

ACCEPTABELT NIVEAU

1 teendt sub-pixel 3
2 sammenliggende tendte sub-pixler 1
3 Tre sammenliggende teendte sub-pixler (en hvid pixel) 0
Afstand mellem to bright dot-defekter* >15mm
Samlede bright dot-defekter af alle typer 3

BLACK DOT-DEFEKTER

ACCEPTABELT NIVEAU

1 merk sub-pixel 5 eller feerre

2 sammenliggende mearke sub-pixler 2 eller feerre

3 sammenliggende mgarke sub-pixler 0

Afstand mellem to black dot-defekter*® >15mm
Samlede black dot-defekter af alle typer 5 eller feerre
SAMLEDE DOT-DEFEKTER ACCEPTABELT NIVEAU
Samlede bright- eller black dot-defekter af alle typer 5 eller feerre

@ Bemark

1. 1 eller 2 sammenliggende sub-pixel-defekter = 1 dot-defekt

2. Denne monitor er i overensstemmelse med 1SO9241-307 (1509241-307: Testmetoder for
ergonimiske krav, analyse og overensstemmelse pd elektroniske visuelle skaerme)
3. 15O9241-307 is de opvolger van de voormalige ISO13406-standaard, die op 13 november 2008

ingetrokken is door de International Organisation for Standardisation (ISO).




7.2 Kundeservice og garanti

For oplysninger om garantidaekning og gezeldende stgttekrav i dit omrdde, bedes du besgge www.
philips.com/support website for details. Du kan ogsa kontakte dit lokale Philips kundeservicecenter via
nummeret nedenfor.

Kontaktoplysninger i Vesteuropa:

Land ASC Kundeservice tlf Pris

Germany Siemens 1&S +49 01803 386 853 € 0,09

United Kingdom Invec Scotland +44 0207 949 0069 Local call tariff
Ireland Invec Scotland +353 01 601 1161 Local call tariff
Spain Eatsa Spain +34 902 888 /85 €010

Finland A-novo +358 09 2290 1908 Local call tariff
France A-novo +33 082161 1658 €009

Greece Allman Hellas +30 00800 3122 1223 Free of charge
Italy A-novo +39 840 320 041 € 0,08
Netherlands E Care +31 0900 0400 063 €010
Denmark A-novo +45 3525 8761 Local call tariff
Norway A-novo +47 2270 8250 Local call tariff
Sweden A-novo +46 08 632 0016 Local call tariff
Poland Zolter +48 0223491505 Local call tariff
Austria Siemens 1&S +43 0810 000206 €007

Belgium E Care +32 078 250851 € 0,06
Luxembourg E Care +352 26 84 30 00 Local call tariff
Portugal Eatsa Spain +351 2 1359 1440 Local call tariff
Switzerland A-novo +41 02 2310 2116 Local call tariff
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Kontaktoplysninger til CENTRAL- OG @STEUROPA:

Land Callcenter ASC Kundeservice tlf
Belarus NA IBA +37517 217 3386
Bulgaria NA LAN Service +359 2 960 2360
Croatia NA Renoprom +385 1 333 0974
Estonia NA FUJITSU +372 6519900
Latvia NA “ServiceNet LV" Ltd. +371 7460399
Lithuania NA UAB "Servicenet" +370 7400088
Romania NA Blue Ridge Intl. +40 21 2101969
oo f‘egm NA Kim Tec d.0o, +381 1120 70 684
Slovenia NA PC H.and +386 1 530 08 24
Ulkfie NA Comel +380 562320045
NA Topaz-Service Company +38 044 245 73 31
S NA CPS +7 (495) 645 6746 (for repair)
NA CEEE Partners +7 (495) 645 3010 (for sales)
Slovakia NA Datalan Service +421 2 49207155
Turkey NA Techpro +90 212 444 4 832
Czech Rep. NA Asupport 800 100 697
Hungary NA Serware , +36 1 2426331
NA Profi Service +36 1 814 8080

Kontaktoplysninger til LATINAMERIKA:

Land Callcenter
Brazil

: Vermont
Argentina

Kundeservice tlf
0800-7254101

0800 3330 856

Kontaktoplysninger til Kina:
Kina
Kundeservice tlf: 4008 800 008

Kontaktoplysninger til NORDAMERIKA:

Land Callcenter ASC Kundeservice tIf
US.A. TOS Teleplan (877) 835-1838
Canada Supercom Supercom (800) 479-6696




Kontaktoplysninger til APMEA:

Land Callcenter ASC Kundeservice tlf
Australia NA AGOS NETWORK PTY LTD [ 1300 360 386
New Zealand | NA Visual Group Ltd. 0800 657447
Hong Kong / : Hong Kong:Tel: +852 2619 9639
Macau NA Smart Pixels Technology Ltd. Macau:Tel: (853)-0800-987
: Tel: 1 800 425 6396
India NA REDINGTON INDIA LTD SMS: PLILIPS to 56677
: : : : : Tel: 62 21 75909053, 75909056,
Indonesia NA PT. Gadingsari elektronika Prima 7511530
South Korea NA PCS One Korea Ltd. 080-600-6600
: After Market Solutions (CE)
Malaysia NA Sdn Bhd 603 7953 3370
Pakistan NA Philips Consumer Service (9221) 2737411-16
Philips Electronics Singapore
Singapore NA Pte Ltd (Philips Consumer Care | (65) 6882 3999
Center)
PCCW
Taiwan Teleservices FETEC.CO 0800-231-099
Taiwan
Thailand NA Axis Computer System Co,, Ltd. | (662) 934-5498
South Africa NA SylvaraTechnologies Pty Ltd 086 0000 888
cnited Arab | o AL SHAHD COMPUTER LL.C |00971 4 2276525
Emirates
Israel NA Eastronics LTD 1-800-567000
EPT Service Informatic +84 8 38248007 Ho Chi Minh City
Vietnam NA C Ltd +84 5113.562666 Danang City
S +84 5113.562666 Can tho Province
I : (02) 633-4533 to 34,
Philippines NA Glee Electronics, Inc. (02) 637-6559 to 60
Sri Lanka NA no dllstrlbutor and/or service
provider currently
Bancladesh NA Distributor: Computer Source | 880-2-9141747,9127592
e Ltd (warranty buy-out) 880-2-8128848 / 52
Nepal NA Distributor: Syakar Co. Ltd 977-1-4222395
(warranty buy-out)
Distributor: Neat Technology
Cambodia NA Pte Ltd (Singapore) (warranty | 855-023-999992
buy-out)
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8. Fejlfinding og FAQ

8.1 Fejlfinding

Denne side omhandler problemer, som kan
klares af brugeren selv. Hvis problemet stadig er
der, efter at du har prevet disse lgsninger, skal
du kontakte Philips" kundeservice.

1 Almindelige problemer

Intet billede (stremdiode lyser ikke)
* Kontroller, at ledningen er sat i
stikkontakten og bag pa skaermen.

e Kontroller fgrst, at stremkontakten foran
pa skaermen er i OFF (FRA), og stil den
derefter pa ON (TIL).

Intet billede (stremdiode lyser hvid)
* Kontroller, at der er teendt for computeren.

* Kontroller, at signalkablet er korrekt
forbundet til computeren.

* Kontroller, at der ikke er nogen bgjede
stikben pd signalkablets stik. Hvis der er det,
skal du fa kablet repareret eller udskiftet.

* Energisparefunktionen kan veere aktiveret

Skaerm siger

Attention

Check cable connection

* Kontroller, at signalkablet er korrekt
forbundet til computeren. (Se ogsa Quick
Start Guiden).

* Tjek, om skaermkablets stikben er bgjede.

* Kontroller, at der er teendt for computeren.

AUTO (AUTOM.) knappen virker ikke

* Den automatiske funktion fungerer kun i
VGA analog-tilstand. Hvis resultatet ikke er
tilfredsstillende, kan der foretages manuelle
justeringer via OSD-menuen.
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S Bemark
Den automatiske funktion er ikke ngdvendig i
DVI digrtal-tilstand.

Synlige tegn pa rog eller gnister
* Forsgg ikke selv at fejlfinde

e Traek straks skaermens stik ud af
stikkontakten

* Kontakt straks en reprasentant fra Philips
kundeafdeling.

H Billedproblemer

Billedet er ikke centreret
* Justér billedets position med funktionen
“Auto” (Automatisk) i OSD-menuerne.

* Juster billedpositionen med Phase/Clock

(Fase/Klokke) i OSD hovedmenuen. Den
kan kun bruges i VGA-tilstand.

Billede vibrerer pa skaermen
* Tjek at signalkablet er korrekt forbundet til
grafikkortet eller pc'en.

Lodret flimren

* Justér billedet med funktionen “Auto”
(Automatisk) i OSD-menuerne.

* Eliminer de lodrette bjeelker med Phase/

Clock (Fase/Klokke) i OSD hovedmenuen.
Den kan kun bruges i VGA-tilstand.

Vandret flimren

£ =

L

* Justér billedet med funktionen “Auto”
(Automatisk) i OSD-menuerne.

* Eliminer de lodrette bjeelker med Phase/
Clock (Fase/Klokke) i OSD hovedmenuen.
Den kan kun bruges i VGA-tilstand.



Billedet er slaret, uklart eller for markt
* Indstil kontrasten og lysstyrken i OSD.

Der forbliver et “efterbillede”,
“brandmarkerne” eller “spogelsesbillede”,
efter at der er slukket for stremmen.

» Uafbrudt visning af et stilbillede over
lzngere tid, kan fordrsage “brandmeerker”,
ogsa kendt som “efterbilleder” eller
“spogelsesbilleder” pa skaermen.
“Breendmaerker”, “efterbilleder”, og

“spogelsesbilleder” er et velkendt fenomen
i LCD skeermteknologi. | de fleste tilfeelde vil

“brandmerkerne” eller “efterbilledet” eller
“spogelsesbilledet” forsvinde gradvist, efter
skeermen er blevet slukket.

* Sprg altid for at aktivere en pauseskarm,
der bevager sig, nar skermen efterlades
uden at blive anvendt.

* Du skal altid bruge en pauseskerm eller
et andet program, der opdaterer skeermen
regelmassigt, hvis LCD skaermen viser
statisk materiale i lengere perioder.

* Alvorlig “brandmarkerne’”- eller
“efterbillede”- eller “spagelsesbillede’-
symptomer forsvinder ikke og kan ikke
repareres. Ovennavnte skader er ikke
daekket af garantien.

Billedet er forvraenget. Tekst er utydelig eller

sloret.

* Indstil pc’ens skermoplasning som
skeermens anbefalede, native oplasning.

Der ses rode, bld, merke og hvide pletter pa

skarmen

* De resterende prikker er normale i den
flydende krystal-teknik, der bruges i dag.
Se politikken om pixels for yderligere
oplysninger.

“Taendt” lyset er for kraftigt, og det er

forstyrrende

*  Du kan justere “Teendt"” lyset med
Stremdiode i OSD-menuerne.

For yderligere hjzlp, se venligst listen over
Forbrugerinformationscentre og kontakt
Philips's Kundeservice.
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8.2

SP1:

Sv.:

SP2

Sv.:

SP3:

Sv.:

Generelle FAQ

Hvad skal jeg gare, hvis skeermen under
installationen viser “Cannot display
this video mode” (Kan ikke vise denne
videotilstand)?
Den anbefalede oplasning pa denne
skeerm: 1680 x 1050 pa 60 Hz.
Frakobl alle kabler og forbind derefter
pc'en til skeermen, som du brugte for.

I Windows Startmenuen, veelg Settings/
Control Panel (Indstillinger/Kontrolpanel). |
Control Panel (Kontrolpanel)-vinduet velg
Display (Skaerm)-ikonet. | Egenskaber for
Skaerm-vinduet vealg “Settings” (Indstillinger)
fanebladet. Under indstillinger-fanen, under
feltet “desktop area" (skrivebordsomrade),
skal du stille justeringsbjeelken pa 1680 x
1050 pixler.

Abn “Advanced Properties’ (Avanceret) og
indstil opdateringshastigheden pa 60 Hz og
klik derefter pa OK.

Genstart computeren og gentag trinene
2 og 3 og bekraft, at pc'en er indstillet til
1680 x 1050 ved 60 Hz.

Luk for computeren, frakobl den gamle
skerm og genforbind Philips LCD skzermen.

Teend for skeermen og derefter for pc'en.

: Hvad er den anbefalede

opdateringshastighed pa LCD skaermen?
Den anbefalede opdateringshastighed

pa LCD skeerme er 60 Hz. | tilfeelde af
forstyrrelser pa skeermen skal du sette
den op til 75 Hz og se, om dette fierner
forstyrrelserne.

Hvad er .inf og .icm filerne pa cd-
rom'en? Hvordan installerer jeg driverne
(.inf og .icm)?

Dette er skaermens driverfiler. Installer
driverne i henhold til brugervejledningen.
Computeren kan bede dig om
skeermdrivere (.inf og .icm filer) eller om
en driverdisk, ndr du installerer skarmen
forste gang. Indset (medfelgende cd-rom)



SP4
Sv.:

SP5:

Sv.:

SPé:

Sv.:

SP7:

Sv.:

SP8:

Sv.:

| pakken i henhold til vejledningerne.
Skeermdrivere (.inf og .icm filer) installeres
automatisk.

: Hvordan justerer jeg oplgsningen?
Skarmkortet/grafikdriveren og skeermen
bestemmer sammen oplasningerne til
radighed. Du kan velge den gnskede
oplgsning under “Egenskaber for Skaerm” i
Windows® kontrolpanelet.

Hvad, hvis jeg “farer vild”, mens jeg
justerer skermen?

Sa skal du blot trykke pa OK og derefter
veelge “Reset” (Nulstil) for at gd tilbage til
de oprindelige fabriksindstillinger.

Er LCD-skaermen modstandsdygtig
overfor ridser?

Det anbefales generelt ikke at udsatte
skeermens overflade for kraftige sted.
Den er beskyttet mod skarpe og stumpe
ting. Nar du handterer skaermen, sd

pas pa ikke at trykke for kraftigt pa
skeermens overflade. Det kan pavirke
garantibetingelserne.

Hvordan renger jeg LCD skarmens
overflade!?

Til normal renggring skal du blot anvende
en ren, blad klud. Til kraftigere rengering
skal du bruge isopropylalkohol. Brug

ikke andre oplasningsmidler sdsom
ethylalkohol, ethanol, acetone, hexan osv.

Kan jeg @ndre skaermens farveindstilling?
Ja, du kan @ndre farveindstillingen via
OSD pa fglgende made:

Tryk pa “OK" for at vise OSD (On Screen
Display) menuen

Tryk pa “Down Arrow (Ned-pil) for
at veelge indstillingen “Color” (Farve),
og tryk derefter pa “OK" for at angive
farveindstillingen. Der er tre indstillinger,
som vist nedenfor.

1. Farvetemperatur med to indstillinger,
6500K og 9300K. Med indstillinger i
6500K omradet virker skarmen “‘varm,
med en rad-hvid farvetone”, mens en
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9300K temperatur giver en “kold bla-
hvid farvetone”.

2. sRGB - dette er en standardindstilling,
som sikrer korrekt udveksling af farver
mellem forskellige enheder (f.eks.
digitale kameraer; skeerme printere,
skannere osv).

3. User Define (Brugerdefineret) -
brugeren kan veelge sin foretrukne
farveindstilling ved at indstille den rede,
gronne og bld farve.

& Bemerk

En malning af farven pa lys, der udstrales fra
et objekt, mens det opvarmes. Denne maling
udtrykkes pa en absolut skala (kelvingrader).
Lavere kelvingrader sasom 2004K er rgde,
hojere temperaturer sasom 9300K er bla.
Neutral temperatur, 6504K; er hvid.

SP9: Kan jeg forbinde min LCD skaerm til
enhver pc, arbejdsstation eller Mac?

Ja. Alle Philips LCD skaerme er fuldt
kompatible med standard pc'er, Mac og
arbejdsstationer. En ledningsadapter kan
veere ngdvendig for at kunne forbinde
skeermen til dit Mac-system.Vi anbefaler,
at du kontakter Philips salgsreprasentant
for yderligere oplysninger.

SP10: Er Philips LCD skaerme “Plug & Play”?

Sv..  Ja, skeermene er “Plug & Play” kompatible
med Windows 7/Vista/XP/NT, Mac OSX
og Linux

SP11: Hvad er “billedkleebning” eller
“billedindbraending” eller “efterbillede”
eller “spogelsesbillede” pa LCD skarme?
Uafbrudt visning af et stilbillede over
lzngere tid, kan fordrsage “brandmaerker”,
ogsa kendt som “efterbilleder” eller
“spagelsesbilleder” pa skaermen.
“Braendmaerker”, “efterbilleder”, og
“spggelsesbilleder” er et velkendt
fenomen i LCD skaermteknologi. | de
fleste tilfelde vil “brandmaerkerne’” eller
“efterbilledet” eller “spagelsesbilledet”

Sv.:

Sv.:



forsvinde gradvist, efter skeermen er
blevet slukket.

Serg altid for at aktivere en pauseskaerm,
der beveeger sig, nar skeermen efterlades
uden at blive anvendt.

Du skal altid bruge en pauseskaerm

eller et andet program, der opdaterer
skeermen regelmaessigt, hvis LCD
skaermen viser statisk materiale i lengere
perioder.

O Advarsel

Hvis der ikke aktiveres en pauseskaerm eller
et program til periodisk skeermopdatering, kan
det resultere i alvorlige “fastbraendinger” eller
“efterladte billeder” eller "spagelsesbilleder”,
hvis symptomer hverken forsvinder eller kan
repareres. Ovenstaende skade deekkes ikke af
garantien.

SP12: Hvorfor viser skermen ikke skarp tekst?
Hvorfor viser den forrevne tegn?

Sv.:  Din LCD monitor virker bedst pd dens
native oplasning pa 1680 x 1050 ved
60 Hz. Brug denne oplasning for at opna
det bedste billede.
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